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Eclipse

| Eclipse 소개

/ 1999년 시작된 Java Project

/ 2001년 IBM 오픈소스프로젝트

/자바로 작성된 자유 소프트웨어 (EPL License)

/다양한 언어를 지원하는 통합 개발환경
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Eclipse

| Eclipse 설치

/ http://eclipse.org

/ Windows 7 64 Bit 다운로드

/ Windows, C:\eclipse
Mac, /Application/eclipse

/ 압축해제

5/91

5Thursday, March 21, 13

http://eclipse.org
http://eclipse.org


Eclipse

| Eclipse 설치

/ Workspace 설정
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Eclipse

| Eclipse 설치

/ JDK 설치

/ http://www.oracle.com/
technetwork/java/javase/
downloads/index.html
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Eclipse

| Eclipse 설치

/ JDK 설치

/ OS에 맞춰서 다운로드
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Eclipse

| Eclipse 설치

/ JDK 설치

/ 환경변수설정
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Eclipse

| Eclipse 설치

/ JDK 설치

/ 환경변수설정
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Eclipse

| Eclipse 설치

/ JDK 설치

/ 환경변수설정
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Eclipse

| Eclipse 설치

/ JDK 설치

/ 환경변수설정
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Eclipse

| Eclipse 설치

/ JDK 설치

/ 환경변수설정
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Eclipse

| Eclipse 설치

/ JDK 설치

/ 환경변수설정

/ Mac의 경우 자동설치
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Eclipse

| Eclipse 사용법

/ 이클립스를 실행하면
처음에 Workspace를
설정하여야 한다.

/ 원하는 경로를 입력한 후 OK버튼을 누른다.
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Eclipse

| Eclipse 사용법

/ Package Explorer

/ Editor

/ Console

/ 크게 3가지 영역으로 구성
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Eclipse

| Eclipse 사용법

/ Package Explorer에서 우클릭,

/ New -> Project
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Eclipse

| Eclipse 사용법

/ Java Project 선택

/ Next 클릭
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Eclipse

| Eclipse 사용법

/ Project name에 원하는 제목을 
적고 Finish 클릭.
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Eclipse

| Eclipse 사용법

/ src에서 우클릭

/ New -> Class 클릭
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Eclipse

| Eclipse 사용법

/ Class Name,

/ public static ... 체크

/ Finish 클릭

21/91

21Thursday, March 21, 13



Eclipse

| Eclipse 사용법

/ 다음과 같이 작성

22/91

22Thursday, March 21, 13



Eclipse

| Eclipse 사용법

/ Run As -> Java Application
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Eclipse

| Eclipse 사용법

/ Console 영역에서 내용 확인
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JUnit
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JUnit

| 개요

/ Java를 위한 오픈 소스 테스트 프레임워크

/ 콘솔 환경에서 명령행으로도 실행 가능

/ Eclipse에는 기본 탑재되어 있음 (설치 필요없음)
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JUnit

|
단위 및 기능 테스트

/
단위테스트(Unit Test)란?

/
프로그램의 기본 단위가 제대로 동작하는지 테스트 하는 것.

/
Java 기본단위인 클래스와 메서드를 테스트 함.

/
기능테스트(Functional Test)란?

/
소프트 웨어 전체가 제대로 동작하는지 테스트 하는 것.

/
전체 소트트웨어를 사용자 입장에서 잘 동작하는지 테스트 하는 것.

/
별도 테스트 팀이 수행, 개발과는 다른 도구와 기술 사용.
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JUnit

| 사용법

/ 간단한 소스를 입력

/ add() a+b를 a=b로 오타냄
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JUnit

| 사용법

/ New -> JUnit Test Case
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JUnit

| 사용법

/ 다음과 같이 작성,

/ setUpBeforeClass(), 
tearDownAfterClass()의 경우 
클래스가 실행될때 각각 한번
씩 실행됨

/ setUp(), tearDown()의 경우 각 
테스트 메서드가 실행되기 전 
후에 한번씩 실행됨
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JUnit

| 사용법

/ 다음과 같이 생성됨
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위와 같이 작성
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JUnit

| 사용법

/ Run As -> JUnit Test
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JUnit

Click!
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JUnit

Highlight!!
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JUnit

| 사용법

/ 틀린 부분 수정 후 다시 Run As -> JUnit Test 
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JUnit
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JUnit

| 구성요소

/ Annotation List
@Before Test method가 실행되기 전에 실행되는 method

@After Test method가 실행되고 난 후에 실행되는 method

@Test
JUnit의 test class를 생성할 때 ‘extends TestCase’를 없애준다.
method앞의 ‘test’라고 붙여줘야 하는 불편함을 없애준다.
TestCase를 확장하지 않았기 때문에 ‘assert*’ method를 사용하기 위해서는
‘import static org.junit.Assert.*,’static imports해준다.

@Test
(expected Exception.class)

@Test의 expected에 class method 안의 try, catch에서 발생한 예외를 정의해준다.
정의를 해준 예외는 method안에서 try, catch해 줄 필요가 없다.

@Test
(timeout=5000)

@test의 timeout은 method에 시간적인 제한을 줄 수 있다.
성능test시 일정 시간만 실행 후에 종료를 할 수 있다.

@Ignore @Ignore를 통해서 test method실행시 해당 method를 제외할 수 있다.
제외하는 이유를 적어서 추후에 직관적으로 확인 할 수도 있다. 38/91
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JUnit

| 구성요소

/ Class

Assert 테스트하려는 조건을 명시한다. assert메서드는 조건이 만족되면 아무일도 없었다는 
듯이 조용히 지나가며, 만족되지 못하면 예외를 던진다.

Test @Test 애노테이션이 부여된 메소드로, 하나의 테스트를 뜻한다. JUnit은 먼저 메서드
를 포함하는 클래스의 인스턴스를 만들고, 애노테이션된 메서드를 찾아 호출한다.

Test Class @Test 메서드를 포함한 클래스이다.

Suite Suite는 여러 테스트 클래스를 하나로 묶는 수단을 제공한다.

Runner 러너는 테스트를 실행시킨다. 
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JUnit

| 구성요소

/ Method

assertEquals(primitive expected, primitive actual) 두 개의 기본형 변수의 값이 같은지 검사

assertEquals(Object expected, Object actual) 두 개의 객체 값이 같은지 검사

assertSame(Object expected, Object actual) 두 개의 객체가 같은지 검사

assertNotSame(Object expected, Object actual) 두 개의 객체가 다른지 검사

assertNull(Object object) 객체가 NULL인지 검사

assertNotNull(Object object) 객체가 NULL이 아닌지 검사

assertTrue(Boolean condition) 조건문이 true인지 검사

assertFalse(Boolean condition) 조건문이 false인지 검사
40/91
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JDepend
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JDepend
|
개요

/
패키지 의존성과 설계 품질의 객체 지향식 측정을 통해, 패키지를 분석하고 관리할 수 있
도록 지원해주는도구.

|
주요기능

/
패키지 의존성 측정

|
관련도구

/
 Eclipse Metrics

|
제작사

/
Clarkware Consulting, Inc (http://andrei.gmxhome.de/jdepend4eclipse/)
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JDepend

| 특징

/ 패키지 별로 의존성 측정가능

/ 패키지 의존성과 관련된 데이터 품질을 수치화하여 표현 

/ 수치화된 의존성 정보를 텍스트 형태로 제공

/ 수치화된 데이터 품질을 그래프로 표현

/ 의존성 정보를 XML형식 파일로 저장가능
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JDepend

| 설치방법

/ Help -> Install New Software
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JDepend

| 설치방법

/ Add 클릭
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JDepend

| 설치방법

/ Location : http://andrei.gmxhome.de/eclipse/

/ Name은 아무거나 상관없음, OK 클릭.
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JDepend

| 설치방법

/ Eclipse Version Select

/ Checkbox Check

/ Next
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JDepend

| 설치방법

/ Next
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JDepend

| 설치방법

/ Check, I accept ..

/ Finish
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JDepend

| 설치방법

/ Waiting ...

/ Finish, then Click Yes.
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JDepend

| 사용방법

/ 원하는 패키지 선택

/ Run JDepend analysis 클릭
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JDepend

| 사용방법

/ Packages

/ Dependencies

/ Metrics

/ 3개의 창 확인가능.
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JDepend

| 사용방법

/ Packages View

/ 여러개의 패키지를 포
함하고 있는 경우 이
곳에 모든 패키지 정
보가 표시 됨

/ 하나의 패키지 또는 
여러개의 의존성 정보
를 확인할 수 있음
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JDepend

| 사용방법

/ Dependencies View

/ 선택한 패키지의 의
존성 정보를 수치화 
하여 표현
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JDepend
CC Concrete Class

Interface, Abstract Class를 제외한 Concrete class의 갯수.

AC Abstract Class
추상클래스나 Interface의 갯수. 확장성의 척도.

Ca Afferent Couplings
현재 패키지의 클래스에 의존하고 있는 패키지의 수. 책임의 척도가 됨.

Ce
Efferent Couplings
현재 패키지의 클래스들이 의존하고 있는 패키지의 수. 독립성의 척도가 
됨.

A
Abstractness (A = AC/CC+AC)
추상화 정도를 나타내며, 0~1 사이의 값을 가짐.
0은 완전 구체적인 패키지,1은 추상적인 패키지를 나타낸다.

I
Instability (I = Ce(Ce + Ca))
변화에 대한 안정성을 나타내며, 0~1 사이의 값을 가짐.
0은 외부 변화에도 끄떡없는 패키지이며, 0은 작은변화에도 쉽게 흔들
릴 수 있는 패키지를 나타낸다.

D
Distance To Main Sequence
Main Sequence로부터의 거리를 나타내며, 0은 Main Sequence와 가깝
고, 1은 먼 상태.
Main Sequence 란 이상적인 패키지로 완전 추상적이면서 안정적이거나 
완전 구체적이면서 불안정한 패키지를 나타낸다.

Cycle
Package Dependency Cycle
패키지들 상호 간에 의존성을 가지고 있을 때 발생
안 좋은 상황이기 때문에 경고 아이콘으로 보여짐

|
사용방법

/
Dependencies View

/
수치에 대한 정의
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JDepend

| 사용방법

/ Metrics View

/ Dependencies 에서 
수치화된 정보를 그
래프로 보여줌
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JDepend
|
사용방법

/
Metrics View

/
추상화되어 있는 패키지

/
Ce는 없고 Ca가 발생하는 것이 좋습니다. 즉 안정성이 높은 상태로 유지되는 것이 바람직합니다.

/
구체화되어 있는 패키지

/
Ca는 없고 Ce가 발생하는 것이 좋습니다. 외부 패키지와의 의존관계를 가질 경우 Concrete Class
보다는 Interface를 통하여 의존관계를 가지는 것이 좋은 설계입니다. 즉, 구체화되어 있는 패키
지는 안정성이 낮은 상태로 유지되는 것이 좋습니다.

/
Main Sequence

/
이상적인 패키지로 완전 추상적이면서 안정적이거나, 완전 구체적이면서 불안정한 패키지를 나
타냅니다. D값은 A와 I의 종합이 적절하게 잘 유지되도록 고려할 때 판단할 수 있는 좋은 근거가 
될 수 있습니다.
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JDepend

| 사용방법

/ Metrics View

Instability →

A
b
st

ra
ct

ne
ss

 →

Very High Stability
Interface Packages

Very High Instability
Implementation Packages
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JDepend

| 사용방법

/ Show JDepend output, 클릭
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JDepend

| 사용방법

/ Dependencies에서
수치화된 정보를 
Console에서 텍스트로
확인 가능
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JDepend

| 사용방법

/ Dependencies정보를 XML로 보여줌

/ Save JDepend output 클릭
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JDepend

| 사용방법

/ Yes 클릭

/ 저장경로 선택 후 저장
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JDepend

| 사용방법

/ XML로 저장된 
Dependencies정보 확인
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JDepend

| 결론

/ 현재패키지의 의존성 및 Cycle Dependency의 문제점을 찾기 쉽다.

/ 개발완료가 아닌 개발 중에도 문제점을 체크할 수 있어 사용이 용이
하다.

/ 자바의 경우 외부 라이브러리 의존관계가 복잡, 그에 대한 해결책은 
내가 만들고 있는 시스템 내부 의존관계에 대한 정립, 아키텍처를 
가진 설계와 접근, 검증과정의 도입이라고 볼 수 있다.  그 때 패키지 
레벨의 의존관계에 대한 분석을 통해 시스템 아키텍처를 검토할때 
많은 도움을 주는 툴이다.
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JDepend
| 결론

/
의존관계 분석에서 중요한 것은 순환의존관계이다. 이는 매우 안좋은 설계이며 
단방향 의존성이 중요한 이유는 다음과 같다.

/
순환참조는 코드를 악화시킨다.

/
패키지 재사용에 제한이 생긴다.

/
B를 사용하려면 A를 컴파일해야하는데, A는 다시 B를 컴파일해야 하는 상황
이 발생한다.

/
이러한 문제를 해결하기 위해선 패키지들을 개념적인 모듈로 묶어야 한다. 또한 
모듈을 만들어 낼 땐 개념적인 경계와 더불어 배포도 고려해야한다.

65/91

65Thursday, March 21, 13



Clover
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Clover

| Test Coverage

/ 소프트웨어의 각 부분을 얼마나 테스트 실행했는지 분석한 값

/ 신규/개편 개발이나 서스테이닝 개발을 할 때 새로 추가하거나 수정한 

소스 코드는 코드 완성도를 높이기 위해 테스트 코드를 작성하여 개발

자 테스트를 수행해야 한다. 개발자가 자신이 작성한 코드를 충분히 

테스트하지 않아서 QA단계에서 문제가 발견되면 그 때 다시 개발자가 

일일이 코드를 수정해야 하고 전체적인 일정에 차질이 올 수 있다. 이

러한 문제점을 해결하기 위해 테스트를 충분히 했는지 확인할 수 있는 

방법이 Test Coverage이다.
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Clover
|
Test Coverage

/
명세기반 Test Coverage

/
가장 간단한 측정법, 시스템 명세중 테스트한 명세의 비율을 계산

/
테스트한 명세 개수 / 전체 명세 개수 * 100

/
코드기반 Test Coverage(Code Coverage)

/
명세 내용과 실제 구현내용이 달라 명세기반 Test Coverage가 큰 의미를 갖지 못하
는 경우 사용되며, 동적 테스트 방법의 하나로서 실제로 동작하는 소스 코드가 기본
이며 언제나 명확한 값을 얻을 수 있음

/
테스트된 코드 구성요소 개수 / 전체코드 구성 요소 개수 * 100
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Clover

| Test Coverage

/ 명세기반 Test Coverage만으로는 신뢰성이 떨어지고, Code 
Coverage만으로는 코드로 표현할 수 없는 데이터베이스 스키
마 등 코드 외적인 요소는 측정할 수 없으므로 시스템의 안정
성을 보장할 수 없다.

/ 따라서, 두가지 Test Coverage를 함께 사용하여야 한다.
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Clover
|
Code Coverage의 유형

/
기본적인 방법

/
Statement Coverage

/
Decision Coverage

/
Condition Coverage

/
Multiple Condition Coverage

/
Condition/Decision Coverage

/
Modified Condition/Decision Coverage

/
Path Coverage
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Clover
|

Code Coverage의 유형

/
그 밖의 방법들

/
Function Coverage

/
Call Coverage

/
Linear Code Sequence and Jump (LCSAJ) Coverage

/
Data Flow Coverage

/
Object Code Branch Coverage

/
Loop Coverage

/
Race Coverage

/
Relational Operator Coverage

/
Weak Mutation Coverage

/
각 유형에 따라서 같은 코드 구성 요소를 보더라도 다른 결과가 나오므로 필요에 따라서 적절한 유형을 선택해
야 함.
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Clover

| Code Coverage 측정 도구

/ 주로 소스코드를 컴파일하기 전에 Coverage를 측정하기 위한 계측코드를 
삽입하고 테스트하면서 계측코드가 얼마나 실행되었는지 측정한다. 따라
서 언어마다 사용하는 도구가 다르다.

/ Java

/ Cobertura, EMMA, Clover ...

/ C/C++

/ GCOV, BullsEyeCoverage ...
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Clover

| 개요

/ http://atlassian.com/software/clover

/ Atlassian이라는 애자일 지원 도구 전문업체가 개발

/ 소스코드에 직접 계측코드를 삽입하여 Code Coverage를 측정, 
Eclipse, Ant, Maven 등과 쉽게 통합할 수 있다.

/ 분석 결과 중 하나로 클래스의 복잡도와 Code
Coverage 분석 결과를 함께 보여주는 그래프.
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Clover

| 동작 원리

/ 컴파일러 호출을 가로채어 소스코드에 계측 코드를 삽입

/ 자바 컴파일러로 컴파일

/ 계측 코드를 삽입할 때 clover.db라는 파일 생성

/ 최종 바이너리 실행중에 clover.db에 실행된 코드를 기록

/ 실행 이후 clover.db의 내용을 html 또는 xml 등의 형식으로 출력
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Clover

| 설치과정

/
Help -> Install New Software 선택
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Clover

| 설치과정

/
Work With에 http://update.atlassian.com/eclipse/clover 입력 후 Add
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Clover

| 설치과정

/
설치할 Clover Plugin 선택 후 Next
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Clover

| 설치과정

/
I accept .. 선택 후 Finish 클릭

/
그 후 Restart now 클릭
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Clover

| 설치과정

/
License Key 입력 (필요시에)

/
Window -> Preferences
  -> Clover -> License

/
(기본으로 30일 체험판을 제공해준다)
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Clover

| 설치과정

/
License Key 입력하고, OK 클릭
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Clover

| 사용법

/
Project의 오른쪽 클릭

/
Clover

/
Enable on this Project
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Clover

| 사용법

/
기본적으로 4가지 항목에 대한 것을 보여준다.

/
Coverage Explorer, Test Run Explorer, Test Contributions, Clover Dashboard
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Clover

| Coverage Explorer

/
프로젝트의 통계가 표시된다.
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Clover
|

Coverage Dashboard

/

프로젝트에 대한 개요를 가지고 있고, 초점을 맞춰야 할 코드 영역에 대한 
정보를 찾을 수 있는 곳.

/

Coverage 
Test Coverage의 비율에 대한 정보

/

Test Results 
테스트 결과에 대한 정보

/

Most Complex Packages
가장 복잡성을 가진  Package를 보여준다

/

Most Complex Classes 
가장 복잡성을 가진 Class를 보여준다

/

Top Project Risks
가장 복잡하고 적은 Test Coverage를 가진 Class를 보여준다

/

Least Tested Methods
가장 낮은 Test Coverage의 Methods을 보여준다
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Clover

| Java Editor

/
프로젝트의 자바소스 코드편집기에 색상으로 주석을 추가한다.
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Clover
|

Java Editor

/
초록색
Test를 합격하거나 Main Method처럼 외부 Test를 하
는 라인

/
노란색
실패한 Test Coverage

/
회색
제외된 코드

/
빨간색
Coverage가 없는 Code

/
물결표시 붉은선
부분 분기 Coverage(분기의 한부분만 포함되어있으
면 발생)
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Clover

| Test Run Explorer

/
최근에 실행된 테스트를 탐색할 수 있는 곳으로 개별 테스트, 테스트 클래스, 패키지 또는 
전체 프로젝트에 의한 Code Coverage를 볼 수 있다

87/91

87Thursday, March 21, 13



Clover

| Test Contributions

/
Unit Test와 선택한 자바소스파일에 대한 
Coverage를 보여준다.
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Clover

| Coverage Treemap Report
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Clover

| Coverage Treemap Report

/
복잡성과 Code Coverage에 의한 Class와 Package를 동시에 비교하여 보여준다.

/
Treemap은 Package에 의해 나눈후, 다시 한번 Class에 의해 나누어 진다. 패키지와 클래스
의 크기는 복잡성을 보여준다. (더 큰 사각형은 더 복잡하다는 것을 의미)

/
색상은 Coverage의 수준을 보여준다. (초록은 가장 Coverage가 잘 되었다는 것을 의미하고 
붉은색은 그 반대이다.)
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